Understanding
Word Field Codes
Field Codes in Word for
Windows can allow users
and support staff to automate
many tasks very easily.

F

By Mike Lewis

Here are a few of the many things that field codes can help you do:

ield codes are one of the key elements of Microsoft Word, yet many users including some experienced support staff - are only dimly aware of their
existence. When users do notice these strange codes, with their curly brackets
and shaded backgrounds, they probably dismiss them as just another of the arcane
mysteries of the word processor. This is a pity because, used creatively, field codes
can open the door to many interesting ways of automating the production of
documents.

●

●

●

●

Build a document automatically in response to information provided by the user.
Thus, you could create a template which prompts for a list of standard paragraph
names and then assembles the specified paragraphs into a new document.
Insert information about the document into the document itself. For example, you
might want to create a document summary sheet, showing the document’s
filename, the author’s name, the date created, word and page counts, and similar
details.
Perform calculations. You could use expression fields to create an “intelligent
document”, such as an invoice or purchase order which automatically calculates
line totals, discounts and tax amounts.
Produce complex numbering systems that go beyond the capabilities of the
Bullets and Numbering dialog.

There are also many more mundane examples of field codes. In fact, there are dozens
of places within Word where field codes are used but the actual codes are hidden
from the user by an insulating layer of dialogs and menu options. If you have ever
used the Insert Date command, or placed a page number in a header, or inserted a
cross reference to a bookmark, you will have used field codes. In these cases, you
don’t have to know how the codes work in order to use them. That said, understanding the mechanics of field codes will help you get the most benefit from them,
especially as there are many things that you can do by directly editing field codes
that you cannot do in dialogs alone.
One reason that field codes are not more widely understood is that they are not
particularly well documented. There are many hundreds of codes and associated
options available, but not all of them are described in Word’s Help file. Although
many of the undocumented codes are now considered obsolete, they still regularly
crop up in documents. Another problem is that there are no debugging aids of any
kind. If you make a mistake in the syntax of a field you might see nothing more
helpful than a blank space within the document’s text.
Nevertheless, field codes are worth persevering with. Although they are less powerful than VBA macros, they are much easier to work with. They have a reasonably
straightforward syntax and they don’t require you to learn a full programming
language. Also, they don’t carry the same security risks as VBA - you will never see
a virus lurking in a field code.

The Mechanics
The most direct way of inserting a field code is to place the cursor at the appropriate
location and then press Ctrl-F9. When you do this, you will immediately see a pair
of curly brackets, with the insertion point between them, set against a grey background. You can now go ahead and type a code between the brackets - for example,
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type DATE to insert a date code. (The details given here apply equally to Word 97
upwards. Field codes are also supported in earlier versions but the mechanics vary
slightly.)
After you have created your {DATE} code, select it and press F9 to make it display
the current date. In general, you need to press F9, or alternatively right-click on the
field and select Update Field, to make the field show its current value. Fields are
also updated when you open the document, so if you open a document containing
a Date field, it will always show the current date. But if you leave the document
open overnight you will have to press F9 to update it the next morning.
You can also instruct Word to update all fields immediately before printing. You do
this by enabling the Update Fields option on the Print tab of the Options dialog. This
is a global setting. It is a useful option for documents that are repeatedly being edited
and printed without necessarily being saved each time - for example, a standard
letter which you modify slightly for different recipients.
A couple of other important keystrokes are Shift-F9 and Alt-F9. Both of these switch
between showing the code and its current value - between {DATE} and the actual
date, for instance. Shift-F9 does this for the selected field, while Alt-F9 does it for all
fields in the document. Alt-F9 has the same effect as toggling the Field Codes
checkbox on the View tab of the Options dialog, but is considerably more convenient.
You can also toggle a specific field by right-clicking on it and selecting Toggle Field
Codes.
Unfortunately, there is no way of seeing both the code and the value for a given field
at the same time, other than by opening a second document windows and setting
the toggle differently in each of them. This works in Word 2000, but not in Word 97,
where the state of the toggle is specific to the document rather than to the window.
By default, fields appear with a grey shaded background whenever they are selected.
This is true whether you are viewing the field itself or its current value. If you don’t
like the grey shading, go to the View tab of the Options dialog and change the setting
of “Field shading” to Never. Alternatively, set this option to Always if you want to
see the shading for all fields, not just the one which is currently selected.

The Insert Field Dialog
Using Ctrl-F9 to insert a field is fine if you know the syntax and the options you
require. If not, you will almost certainly find it more convenient to use the Field
command on the Insert menu. This opens a dialog which helps you build the field
code interactively (Figure 1). You can either choose the required field from the Field
Names list - this displays the names of 72 fields divided into nine categories - or you
can type the name directly into the edit box. Either way, the field will be inserted
into the document when you click the OK button.
For many of the fields listed in the dialog, there are additional formatting options
and other parameters, which you access by clicking the Options button. For example,
with most of the numeric fields, you can choose the position of the decimal point,
whether to show commas between thousands, and so forth. After you make each
choice, be sure to click the Add to Field button (be careful, this is easy to overlook)
to append the relevant switch or parameters to the field in the edit box. You can
subsequently edit the text in the edit box, for instance to add or delete options
manually.
As an example, suppose you want to generate a field code which displays the current
section number in lower-case Roman numerals. First, select the Section field from
the Numbering category in the main Field dialog, and then click the Options button.
In the resulting Field Options dialog (Figure 2), select the appropriate item from the
Formatting list and click Add to Field. The resulting field code in this case would be
{SECTION \* roman}. Note that the curly brackets are visible in the document, but
not in the dialog.

Figure 1 - The Field dialog.
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To help you decide which codes and options to select, the Insert Field dialog displays
an outline of the selected code just below the category list, and a slightly longer
description below the text box. For more detailed information, use the
WhatsThisHelp button; in most cases, this leads to an extensive help screen which
describes the field code and its various options in detail.
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The Insert Field dialog is far from bullet-proof. It performs very little error checking,
and does not prevent you from selecting combinations of options which are either
incompatible or totally meaningless (such as Roman numerals with commas and a
decimal point). Often, you won’t know that you have done anything wrong until
you try to display the field result in the document. By that time, it’s too late to go
back to the dialog. The only way to adjust an incorrect field is to edit it manually, or
to delete it and re-insert it.

Formatting Options
You might have noticed the checkbox in the Insert Field dialog labelled “Preserve
formatting during updates”. With this option enabled, Word will append /* MERGEFORMAT to the field. The effect of this is to retain the field’s original formatting
even if the formatting would otherwise change as a result of updating. If you clear
the option, the field result will take on whatever formatting is applied to the field
itself.
If the field consists of a name only with no options, the character formatting will be
determined from the first character of the field name. So if you are typing with the
Arial font and you insert an {AUTHOR} field, the author’s name will also appear in
Arial. If you later re-format the A of AUTHOR to Gill Sans, the author’s name will
change to Gill Sans the next time that it is updated. However, if the field includes
explicit formatting options, you have to add the /* CHARFORMAT option to make
this work. This must be done manually, as there is no equivalent setting in the Insert
Field dialog.

Numeric Formatting
For fields which return a numeric value, you can choose from a large list of numeric
formats. You can either pick these from the Field Options dialog or insert them
manually by entering the appropriate switches (see Figure 3). The options in the
left-hand list in the dialog determine the overall style of the number: Arabic, Roman,

“For fields which
return a numeric value,
you can choose from a
large list of numeric
formats. You can either
pick these from the Field
Options dialog or insert
them manually.”
Figure 2 - The Field Options dialog.
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alphabetic etc. So to display, say, the number of revisions as a lower-case letter (a=1,
b=2, ...), you would either pick “a b c ...” from the list, or type the field code as
{REVNUM \* alphabetic}. To show it as ordinal text, as in the sentence “This is the
sixth revision.”, the code would be {REVNUM \* OrdText}.
The right-hand list in the Field Options dialog lets you choose a formatting “picture”
for the numeric field. You can specify such options as the character used as the
thousands-separator, the number of digits to appear after the decimal point, whether
to show leading zeros or spaces, whether to show a floating currency sign, and
whether negative numbers should appear with a minus sign or in parentheses. Only
a few basic picture options are listed in the dialog, but you can create many other
formats by combining the picture symbols in various ways.
An example of a field with numeric formatting might be {FILESIZE \M \#
“###,##0.00 ‘ MB’”}. This displays the size of the document, in megabytes, with
commas between thousands, two digits after the decimal point and enough leading
spaces to pad the entire number out to ten characters. Note that the entire formatting
switch (the characters following the \#) is contained in quotes; this is only necessary
if the switch contains embedded spaces, as is the case here, although it does no harm
to include them anyway. The characters MB will be inserted as literal characters at
the end of the formatted number. The \M switch is not part of the number format,
but stipulates that the file size is to be shown in megabytes.

Date and Time Formats
A similar range of formatting options are available for date and time fields. By
default, Word applies the short date format, as shown in the Windows regional or
international settings dialog, but you can override this in various ways. If you add
\l to the field, Word will give you whatever date or time format you last selected in
the Insert Date and Time dialog (not the Insert Field dialog). Or you can choose a
specific format by including \@ followed by the appropriate place-holder characters. Thus, {SAVEDATE \@ “dd MMMM yyyy”} generates the date on which the
document was last saved, with two digits for the day, the month spelled out in full,
and four digits for the year. A full list of these place-holders appears in the Help.

Capitalisation
For fields which produce text (as opposed to numbers or dates), you can choose from
the four capitalisation options listed in Figure 4. For numeric fields that are in fact
formatted to produce numbers, such as Roman numbers or an alphabetical sequence, the case of the switch determines the case of the result. So {SEQ CHAPTER
\* ROMAN} inserts the current chapter number in capital Roman letters, while {SEQ
CHAPTER \* roman} produces the same result but in lower case.

Locking And Unlinking Fields

“For numeric fields that
are in fact formatted to
produce numbers, such
as Roman numbers or
an alphabetical sequence,
the case of the switch
determines the case of
the result.”

There might be times when you have successfully used a field to insert information
into a document but you don’t want the field to be updated when the information
changes. For example, you might use {FILENAME /p} to insert the document’s path
and filename into the text. If you later distribute copies of the document to different
users, you might still want to show the original file’s location, not that of the
individual copies.
You can achieve this by locking the field. To do so, select the field and press Ctrl-F11.
From then on, the field will retain its value, even after you update it. To unlock the
field, select it and press Ctrl-Shift-F11.
\* alphabetic
\* Arabic
\* CardText
\* DollarText
\* Hex
\* OrdText
\* Ordinal
\* roman

Alphabetic characters (a=1, b=2, ... aa=27, etc.)
Arabic numbers
Cardinal text (one, two, etc).
Cheque format (eg, One Hundred Twenty One 37/100)
Hexadecimal numbers
Ordinal text (First, Second, etc.).
Ordinal numbers (1st, 2nd, etc.).
Roman numbers
Figure 3 - Switches for formatting numeric fields
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Similarly, it is possible to unlink a field. In this case, the field is permanently removed
and replaced by its current value, which from then on will be treated as normal text.
To do this, first make sure that the field is up to date, then select it and press
Ctrl-Shift-F9. This is a one-way action - there is no way to convert the text back to a
field later.

Uses For Field Codes
For the rest of the article, we’ll look at some of the more interesting things that can
be achieved with field codes. For the most part, these techniques require you to work
with the codes directly, rather than accessing them through Word’s dialogs and
menus. I won’t attempt to describe every possible option in every case, as most of
them are covered in the Help.

AutoText Entries
If you want to use a particular phrase many times in your documents but are worried
that you might need to change it in the future, set it up as an AutoText entry, and
use the AutoText field to reference it. For example, if the phrase is PC Support
Advisor, the field would be {AUTOTEXT “PC Support Advisor”}. To avoid having
to enter the field each time, assign it to a key combination or toolbar button. When
you eventually need to change the phrase, just modify the AutoText setting.

Pop-Up Menus
Still on the subject of AutoText, the AutoTextList field creates a pop-up menu
containing a selection of your AutoText entries. The field will look something like
{AUTOTEXTLIST “Sales Department” /s “DeptName” /t “Select the department”}.
In this example, the field will initially appear in the document as Sales Department.
When the user hovers the mouse over it, “Select the department” will appear as a
tooltip. When the user right-clicks on the field, they will see a menu of all the
AutoText entries that were formatted with the DeptName style. The user can then
choose any of these entries to replace the existing text.

References Within Headers
You might sometimes need to create a page header or footer which includes some
actual text from the page. For example, you might want to set up a running head
which includes the name of the current chapter, or you might be producing a phone
directory where you want the header to show the names of the first and last people
listed on the page (“Allen - Beatty”, for instance).
You can achieve this with the StyleRef field. Essentially, the field returns the first
text that it finds which is formatted in a specified style. When used in a page header,
the field will first look for the style in the current page, then search backwards
through the document. So if you format your chapter headings in the ChapHead
style, {STYLEREF “ChapHead”} will always show the current chapter heading,
regardless of where the chapter begins.

“”If you want to use a
particular phrase many
times in your documents
but are worried that you
might need to change it
in the future, set it up
as an AutoText entry,
and use the AutoText
field to reference it.
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By adding /l to the field, you tell it to look for the last occurrence of the style on the
page. If you formatted all the names in your phone directory with the StaffName
style, {STYLEREF “StaffName} - {STYLEREF ”StaffName" /l} would show the first
and last entries on the page.
The style in question can be either a paragraph or character style. If you only want
to show the initial letter of the first and last names on the page, you could create two
identical styles, one for the initial letter and one for the rest of the name, and specify
the first of these in the field.

Document Information
The Document Information category includes about a dozen codes which correspond to the various settings in the document’s Properties window - Author,
Comments, Keywords, Subject, Title etc. The list also includes some statistical items,
such as NumPages and NumWords. In addition, there are two omnibus fields,
DocProperty and Info, which between them can return information about almost
any aspect of the document or the environment. For example, {DOCPROPERTY
NameofApplication} returns the name and version number of Microsoft Word,
while {INFO RevNum} tells you how many times the document has been edited and
saved.
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\* Caps
\* FirstCap
\* Upper
\* Lower

Capitalise the first letter of each word
Capitalise the first letter only
All caps
All lower case
Figure 4 - Capitalisation options.

A useful feature of these fields is that, if you place them in a template, they will
return information about the document based on the template rather than the
template itself. So if you want to create a template for producing letters or memos,
you could include an Author field in the signature, and this will correctly evaluate
to the name of the person who creates the document.
As well as displaying information, some of these fields can also update it. For
instance, placing {COMMENTS “First draft”} in a document will place the specified
phrase in the Comments field in the Properties dialog. This could be used in a
template, in conjunction with the Fillin field (described below), to prompt the user
for comments, keywords, document titles etc whenever a new document is created.

Complex Numbering
The ListNum field gives you several options which are not available from the Bullets
and Numbering dialog. Its basic syntax is {LISTNUM “SeqName”}, where SeqName
represents any name that you assign to a numbering sequence. Once you have
created the field, you can copy and paste it to the start of each of the paragraphs that
you want to number. This makes it particularly easy to sequentially number arbitrary paragraphs scattered around the document.
Nor are you limited to numbering paragraphs, as you can place the ListNum field
anywhere in your text. You can also create nested numbering schemes. Consider the
following paragraph:
Item 1). The estimate includes an allowance for a) time spent on the project; b) the
following pieces of equipment: i) computers, ii) fax machines, iii) scanners; and c)
travel and hotel expenses.
Here there are three distinct levels of numbering all in the same paragraph. Creating
this paragraph is surprisingly easy. Start by inserting the field {LISTNUM “Estimates”} after the word Item (Estimates is just a name invented for this illustration;
any suitable name will do.) Next, copy and paste the field to each of the points where
you want a number to appear - don’t worry about the level of numbering for the
moment.
You will now see a single sequence of numbers, all in the same format: 1), 2) etc. The
next step is to select each second-level number in turn, and click on the Increase
Indent toolbar button. This will demote the number to the next level down, making
it appear as a), b) etc. Finally, repeat this step for the third-level numbers, but this
time click on Increase Indent twice. These numbers will appear as i), ii) and so forth.
The beauty of this arrangement is that, if you re-organise the text by cutting and
pasting, the numbers will be automatically updated to reflect the new sequence. If
any of the fields does not produce the correct result, you can adjust them manually.
To do so, insert \l followed by a number to indicate the level, and \s followed by a
number to indicate the first number of the sequence for that level.

“You can control the
format of the numbers
by adding an additional
parameter to the
ListNum field.”

Going further, you can control the format of the numbers by adding an additional
parameter to the ListNum field. The options include LegalDefault, OutlineDefault
and NumberDefault (see Help for details of the actual formats which these generate)
and any custom formats which you have created.

PCSA
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W

ord provides two field codes, Ask and Fillin, which let you prompt the
user for information. These fields are particularly useful in templates and
mailmerges. The main difference between them is that Ask stores the user’s
input in a bookmark whereas Fillin returns it as the field’s value.

Suppose you have a template which is used to create a standard contract. Most of
the text is pre-defined, but there is one clause which sometimes needs to be edited.
Concluding our two-part article. Instead of letting the user navigate to the clause, delete the existing text and enter
the new text, you could insert the following field in the template in place of the clause
in question:
By Mike Lewis
{FILLIN “Please enter text for holiday clause”, \d “Holidays
will be taken at mutually convenient times.”}
When a user creates a new document based on the template, they will see the
specified prompt (Figure 5). Whatever they type in response will then appear in the
document. If they don’t type anything, the text following the \d switch will be used
instead.
In a mailmerge, there are two ways of using these fields. By adding the \o switch,
you can prompt for a single item of information at the start of the merge, for example,
to ask for a discount amount which is to appear in every letter:
{ASK DiscRate “Enter the discount rate” \o}
Here, DiscRate is the bookmark which will contain the result. The other approach
is to repeat the prompt for each letter printed. In this case, you can vary the wording
according to the data in the current record, like so:
{ASK AppTime “Enter the appointment time for {MERGEFIELD
CustName}”}
This prompt will appear for each record, and will display the current value of the
CustName field. Another useful application for these fields is to prompt the user for
document properties, such as comments or keywords:
{COMMENT {FILLIN “Please enter a comment for this contract”}}
Again, this could be done in a template, so the user will see the prompt each time
they use the template to create a new document.

Calculations
By using expression fields you can make your documents perform a variety of
arithmetic operations. A good use for this would be to create invoices, order forms,
time sheets or similar documents. In an invoice, for example, you might prompt the
user for the number of items sold and then use an expression to calculate the net
total, tax and final total. Of course, you can only go so far with this. If you want to
perform extensive calculations, it might be better to use Excel, perhaps linking the
resulting worksheet into your Word document.
Expression fields begin with an equals sign. This is followed by the expression,
which is evaluated when the field is updated. An expression can contain any
combination of numbers, bookmarks and functions, linked by operators. As an
example, the following field applies the percentage discount rate in the DiscRate
bookmark to the net amount in the NetTotal bookmark:
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{= NetTotal - (NetTotal * DiscRate / 100)}
For another example, consider the following text:
See chapter summary,
cardtext} pages ahead.

{=

{PAGEREF

Summary}

-

{PAGE}

\*

Here, the PageRef field will return the number of the page which contains the
Summary bookmark. The current page number will be subtracted from that number,
and the result formatted as a lower-case word (eg, “six”).
You can use any of the usual arithmetic or relational operators in expressions,
including +, -, *, /, ^, <, <=, <> etc (see Help for the full list).
Expressions can also reference cells in tables, using an Excel-style notation. For
example, {= MAX(Results A1:B2)} will determine the highest value from cells
A1 to B2 of the table bookmarked as Results. If the field occurs in the same table as
the cells it references, the bookmark may be omitted. You can also use the keyword
Above to indicate all cells above the one containing the field, and similarly with
Below, Left and Right.
Although you can insert an expression field through the Field dialog, the dialog does
not give you any help with building the expression itself. A better bet would be to
use the Formula dialog, which is on the Table menu. Contrary to what you might
suppose, this can be used to place an expression anywhere in the document, not just
in a table.

Conditional Operations
To add a further measure of intelligence to your documents, you can use the If field
to compare two values and take a different action depending on the result. This is
especially useful when combined with other fields, and also in mailmerges. The basic
syntax is straightforward, as these examples will show:
{IF Country = “France” “Bonjour” “Hello”}
{IF {MERGEFIELD Limit} < {MERGEFIELD Balance} “Overdrawn”
“OK”}
In the first of these examples the comparison is based on the contents of a bookmark.
The second example compares two data fields in a mailmerge.
As a final example, let’s combine the If field with some other fields:
{IF {FILLIN “Which department (S=Sales, A=Accounts)?”} = “S”
“{INCLUDETEXT c:\\docs\\salesletter.doc}” “{AUTOTEXT AccLetter}”}
The IncludeText field returns an entire document (or the contents of a bookmark
within the document) as the field value. The double backslashes in the file path are
needed because Word interprets a single backslash as a delimiter for field options.

Conclusions
Although we have only looked at a few of the many field codes available, you should
by now appreciate the capabilities of these handy devices. As we have seen, they
are especially powerful when they are combined in various ways. Used as building
blocks, they can help you create all manner of intelligent documents and to achieve
things with the word processor which you could not easily do in any other way.

PCSA
Figure 5 - The prompt seen in
response to a FILLIN field.
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New Reviews from Tech Support Alert
Anti-Trojan Software Reviews
A detailed review of six of the best anti trojan software programs. Two products
were impressive with a clear gap between these and other contenders in their
ability to detect and remove dangerous modern trojans.
Inkjet Printer Cartridge Suppliers
Everyone gets inundated by hundreds of ads for inkjet printer cartridges, all
claiming to be the cheapest or best. But which vendor do you believe? Our
editors decided to put them to the test by anonymously buying printer cartridges
and testing them in our office inkjet printers. Many suppliers disappointed but we
came up with several web sites that offer good quality cheap inkjet cartridges
with impressive customer service.
Windows Backup Software
In this review we looked at 18 different backup software products for home or
SOHO use. In the end we could only recommend six though only two were good
enough to get our “Editor’s Choice” award
The 46 Best Freeware Programs
There are many free utilities that perform as well or better than expensive
commercial products. Our Editor Ian Richards picks out his selection of the very
best freeware programs and he comes up with some real gems.
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